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IBM Rational Build Forge What's New
This guide lists new features and known issues, including workarounds for the issues where
possible.

Before using this information be sure to read the general information under “Notices for IBM
Rational Build Forge” on page 16

First Edition December 2008

This edition applies to IBM® Rational® Build Forge® 7.0.2.

Document version and build: 7.0.2-004.0030.

© Copyright International Business Machines Corporation 2003, 2008. All rights reserved.

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP
Schedule Contract with IBM Corp.
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About the Release
This document provides information about enhancements, resolved problems, and known issues
in version 7.0.2 iFix3 of the Build Forge product.

Installing this release
Before installing this release, obtain the latest version of the IBM Rational Build Forge Installation
Guide.

Express Edition users can use the IBM Rational Build Forge Express Installation Guide.

The installation guide provides detailed instructions for installing the product and upgrading from
previous versions.

Important updates include information related to national language support, prerequisite software,
and supported platforms and databases. Review the information in the installation guide before
starting an installation or upgrade.

Getting the latest release notes
Important updates to this document may have been made since it was prepared for the product
release. Download the updated edition from the IBM Publications Center, as follows:

1. Go to http://www.ibm.com/shop/publications/order.

2. Click Search for Publications.

3. In the Publications number field, enter the document number from the title page of this
document.
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New and Updated Features
No new or updated features are included in 7.0.2 iFix4.
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Fixed in This Version
This section lists problems that have been fixed in the current release. They are identified by their
APAR defect tracking numbers.

The Description text is copied directly from the internal tracking database (RATLC) and may contain
spelling or grammatical errors.

Adaptors

Internal RATLCDescriptionAPAR

RATLC01269693Adaptor names with spaces fail to run on linuxPK73235

RATLC01269305
Altering environments from an inlined adaptor causes
unreliable results/duplicate occurrances of the variablePK73043

Agent

Internal RATLCDescriptionAPAR

RATLC01272147Adaptors cannot run if _MAXJOBS is set to 1 on the agentPK74410

RATLC01268286
Mapping network drives does not work when using -
\\server\share(username,password) 7.0.2+ agentsPK72566

RATLC01237764
The CPU_ARCH variable does not populate Xeon processor
information correctlyPK72462

RATLC01258751
_LOG does not throw a warning or error when it fails to write
outputPK71912

API

Internal RATLCDescriptionAPAR

RATLC01271041PERL API for DBO:User setPasswordExpires incorrectPK73865

RATLC01237761
getPermissionList() API call does not return correct/full list
of permissionsPK72459

RATLC01020506API: Doesn't handle GDD.PK72151

RATLC01266104Deprecated Perl API is not included in distributionPK71485

Documentation

Internal RATLCDescriptionAPAR

RATLC01273260
.defect documentation in online help discusses adaptor links,
which do not work for defect adaptorsPK74895
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Internal RATLCDescriptionAPAR

RATLC01240219
BF: Silently fails when creating a tag variable that starts with
"BF_"PK74497

RATLC01270037
engine parses out $ character from passwords in the _MAP
variablePK73463

RATLC01268701
RFE Mac agent should source logon profile out of the box
for 10.5PK72764

RATLC01268183
stdout is handled differently when running as an adaptor or
as a regular step in BuildForgePK72537

RATLC01259111.put command is overwriting previous records without warningPK68763

RATLC01041590
Importing a project into Build Forge which has notifications
set for projects or steps causes unexpected behaviorPK56103

IDE Plug-ins.

Management Console Engine

Internal RATLCDescriptionAPAR

RATLC01272774Inlined libraries no longer inherit step's environmentPK74685

RATLC01272594Enabling Inherit Tag causes chained projects to hangPK74616

RATLC01272143Broadcast library step always run on first selection hitPK74409

RATLC01271921
Incorrect usage of format strings in .date environment
variables causes steps to failPK74390

RATLC01271943
After upgrading to 7.0.2 ifix 3, messages are populated in
notifications and in the db.log regarding trashingPK74320

RATLC01271058
tag variables incremented when must-change vars prevent
build executionPK73872

RATLC01270848
The ko_KR.ini file has an invalid sprintf entry for
StepStartPart.PK73778

RATLC01270532
step logs not visible after project restart with sync steps
enabledPK73672

RATLC01269788
The BF engine emits Use of uninitialized value in pattern
match errors in the foreground capturePK73297

RATLC01269387
Use of uninitialized value in X messages cause
overpopulation of data in the db.logPK73089

RATLC01269006
Project run from Start on purge are using calling projects
selectorPK72902

RATLC01268481
The bfimport -r process replaces current LDAP users if there
is a like local BF user in the export filePK72646

RATLC01268378
Adapter parameters do not allow spaces in the parameter
listPK72600
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Internal RATLCDescriptionAPAR

RATLC01266224BF_RESERVE setting is not being honored.PK71545

RATLC01266110
Environments are not being applied correctly on projects
chained on Class promotionPK71489

RATLC01265872BF: Build Forge project did not stop on AgentReadErrorPK71409

RATLC01236549bfsched.pl has a memory leak, usage increases greatlyPK71346

RATLC01265241fail chain not executed at project level for "Warning" buildsPK71140

RATLC01258576
Broadcast threaded step fails to complete if one of the steps
which are threaded fails.PK68572

RATLC01047513
threaded step with fail chain causes project to become
unresponsivePK59070

RATLC01045593
Build forge 7.0.2 does not store LDAP passwords in database
with Store User Authentication Locally set to YesPK58446

Management Console User Interface

Internal RATLCDescriptionAPAR

RATLC01273333Insert step/Clone step button don't workPK75089

RATLC01270778project restart forgets variable overrides on sqlserverPK73729

RATLC01267784
Some languages omit AM and PM in long and full date\time
formatsPK72391

RATLC01266066Scrollbar for the job filter drop-down menuPK72134

RATLC01267094
LDAP users using upper case logins fail for Oracle backend
DBs.PK71972

RATLC01263499

Environment lists made up of variables making use of the
new Expand Env Var option do not honor must change
settingPK70381

Quick Reports

Internal RATLCDescriptionAPAR

RATLC01270478quickReport> Query "to" dropdown nonfunctionalPK73655
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Known Issues
This section describes issues that remain open in this release at production time.

BF_RESERVE not honored
BF_RESERVE is not displaying its documented behavior. When used in a selector, it should create
an exclusive relationship between a project and a server. which allows the project to run all steps
without interruption.

Workaround:

1. Edit the project that you want to run exclusively on its server. Set the Sticky property to Sticky

2. Create a new selector (or copy a selector that uses the criteria needed).

a. Click Add Selector Variable

b. Set the Type property to Set Value, Variable to _RESERVE, and Value to a non-numeric
value, for example X.

c. Click Save .

3. Edit the project. In the Selector property, choose new selector you just created.

4. Add variable _RESERVE to all other collectors. However, set value equal to numeric 0.

BF_TAG_PHYS is not interpreted correctly in
notifications
The BF_TAG_PHYS variable cannot be used in project-level notifications. It can be used in
step-level notifications.

MySQL: Quick Reports requires JDBC 5.0 driver for
Apache Tomcat
Quick Reports does not work with the MySQL database if you have the default JDBC 5.1 driver
installed for Apache Tomcat.

Workaround:

Download and install the JDBC 5.0 driver.
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Output from pvcs commands not captured by agent
on AIX
A step containing a pvcs command may not capture all of the expected output if it is run by an
agent on AIX.

Workaround:

Uncomment disable_transcode in bfagent.conf for the agent.

DISK_FREE not updated in Manifest tab for a server
(Windows)
On Windows systems, the DISK_FREE property is not updated in the Manifest tab after clicking
Test Connection or clicking Refresh on the manifest tab. In the Management Console, click
Servers , then click an individual server, then click the Manifest tab. The DISK_FREE property
appears in the properties displayed if it was defined for the server. If the free disk space on the
server changes, then clicking Test Connection or Refresh should cause the value to be updated.

Workaround:

Click on a tab other than Manifest for the server, then click Manifest again.

Files not copied when using Eclipse reflector
Issue: a selected file is not copied over.

Workaround:

When selecting files, select all directories from the root to the file location in addition to the file
itself.

For example, if you want to reflect the file APIException.pm and it is located in the path
perl/BuildForge/Ex, you must check all of these names in the file tree:

• perl

• BuildForge

• Ex

• APIException.pm

If you check APIException.pm but do not check its parent directories up to the root, then the file is
not copied.
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Cannot connect to Microsoft SQL Server database if
a case-sensitive collation is used
If a Build Forge database on Microsoft SQL Server is created using a case-sensitive collation,
Build Forge fails during startup with the following error:

C:\Program Files\BuildForge>BuildForge -d
DBD::ODBC::st execute failed: [Microsoft][ODBC SQL Server Driver][SQL Server]Invalid object
 name 'information_schema.tables'. (SQL-42S02)
[Microsoft][ODBC SQL Server Driver][SQL Server]Statement(s) could not be prepared. 
(SQL-42000)(DBD: st_execute/SQLExecute err=-1) at /PerlApp/BuildForge/DB/Handle.pm line 
211.

8808 /PerlApp/BuildForge/DB/sqlserver.pm(BuildForge::DB::sqlserver):42

8808 /PerlApp/BuildForge/DB/Handle.pm(BuildForge::DB::Handle):413

8808 /PerlApp/BuildForge/DB/ConnectionHandler.pm(BuildForge::DB::ConnectionHandler):34

Workaround: use a case-insensitive collation, such as the default: SQL_Latin1_General_CP1_CI_AS.

Build Forge on Solaris hangs if file descriptor limit
is set higher than 1023
Build Forge on Solaris can hang while trying to acquire a license due to a known issue in the
Rational License Server.

To determine the file descriptor limit, use the following command:

ulimit -n

Workaround: set the file descriptor limit to 1023 or lower. If you do this while Build Forge is hanging,
the license server corrects itself and Build Forge acquires a license immediately.

Environments: using a backslash before ending quote
in a variable assignment does not yield the expected
result
In a variable assignment (.bset env) there are unexpected results if the last character before the
ending quote is a backslash. This true even if preparsing is turned off
(_NO_PREPARSE_COMMAND is true). Example from step execution log:

195 01/28/08 03:45PM STEP .bset env "VAR07=C:\"
196 01/28/08 03:46PM EXEC .bset env 'VAR07' = ''

Workaround: put a space before the ending quote. Example from step execution log:

187 01/28/08 03:45PM STEP .bset env "VAR032=C:\ "
188 01/28/08 03:45PM EXEC .bset env 'VAR032' = 'C:\'
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URL for version 7.0 notification templates might not
work in later versions
The notification template URL provides a link in the notification e-mail to the build report in Build
Forge.

In version 7.0.1, the URL in the notification templates changed. Consequently, when you upgrade
from 7.0 to any later version, the notification template URL links might not work.

If you experience a link error, make the following changes to the notification templates:

1. Select Project > Templates.

2. Click on the notification template to display its properties on the Details tab.

3. In the Body field, locate the URL for the template. The URL should be similar to the one in
the following example:

http://${CONSOLEHOST}:${CONSOLEPORT}/fullcontrol/index.php?mod=projectruns&action=
edit&bfid=${PID}&bfid=${BID}&bfid=${UID}

4. Replace the following 7.0 URL elements with the appropriate 7.0.1 (and later) URL elements:

7.0.1 (and later) URL elements7.0 URL elements

jobsprojectruns

&&amp;

IE6 generates Visual C++ runtime error on save of
data
Internet Explorer 6 users may see a Visual C++ runtime error if the Google toolbar is installed.

As a workaround, in IE go to Tools > Internet Options > Advanced and the uncheck the "Enable
third party browser extensions" option.

Build Forge System i agents need to change standard
agent port (5555)
The standard Build Forge agent port (5555) may be preassigned on a System i server. In this
case, change the Build Forge agent port to an unassigned port before starting the agent. You can
edit the BFagent.conf file directly or use another method to change the port. For details, see the
installation guide.

This problem will be fixed in a future release of the product.
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Duplicate column values not displayed in Quick
Report wizard-generated reports
In wizard-generated reports, column values are not displayed if they duplicate or match the column
value of the previous record. This display convention makes it look like report data is missing when
it is not.

This problem is due to a limitation in the Eclipse reporting tool, BIRT. In a future product release,
the ability to hide or display duplicate column data will be provided.

Some tool tip messages in system configuration
settings are truncated
This display problem is due to a limitation in Mozilla Firefox. Presently, there is no workaround.
The problem will be addressed in a future product release.

Quick Report titles in performance report may be
truncated
Because of a dynamic chart sizing issue in the current version of the Eclipse reporting tool BIRT,
performance report titles may be truncated. Presently, there is no workaround. The problem will
be addressed in a future product release.

Quick Report titles cannot contain periods
When you create a report, you must specify a title. If your report title contains a period, an error
is generated and the report is not created.

Do not include periods in your report titles.

Not all installed components run if the Management
Console is installed to NLV path
Do not use national language characters in the installation directory path name that you specify
for the Management Console. Problems with the installer prevent Build Forge from installing
correctly. Use US-ASCII characters only for the installation directory path. This problem will be
addressed in a future product release.
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Output for Build Forge agent install script (install.sh)
is English-only
If you install the Build Forge agent on a host with an operating system language other than English,
for example French on AIX, the output from the install script is in English. This issue will be
addressed in a future product release.

Install panels for MS Visual Studio .NET for Build
Forge are English-only
The installation panels for installing and setting up MS Visual Studio .NET 2005 for Build Forge
are not internationalized. The panel text is English only.

DB2 error when upgrading from version 3.8 on MySQL
to 7.0.2 on DB2 Express
If you migrate from version 3.8 with MySQL database to version 7.0.2 with DB2 Express, you run
the bfdbmigrate script to migrate the database.

When you restart the Build Forge engine, the migrated database is started up. You might see a
DB2 ALTER TABLE error.

Ignore the DB2 ALTER TABLE error; it is caused by an error in the Build Forge upgrade procedure.
The upgrade procedure will be deprecated in a future release of the product.

Workaround: migrate to version 7.0 or 7.0.1, then migrate version 7.0.2.

Oracle 9.x database fails with ORA-01400 error
The following error occurs only if the Management Console is using an Oracle 9.x database, the
DBD::Oracle driver, and the ora_ph_type parameter is set to a value that strips trailing blanks.

DBD::Oracle::st execute failed: ORA-01400: cannot insert NULL 
into("BLDFORGE"."BF_RESULT"."BF_ENV")

To fix the error, do the following:

Set the ora_ph_type parameter. The value for ora_ph_type in <bf-install>/db.ini must be set to a
value that does not cause the driver to strip trailing blanks. The setting ora_ph_type=96 is
recommended. If set to a value that strips trailing blanks (for example, SQL_VARCHAR), you will
receive an error. The problem does not occur with Oracle 10.

Quick Report fails to start (Microsoft SQL Server and
Oracle databases)
Limitations in JDBC drivers cause the following requirements:
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• Oracle: the database name and SID must use the same value (tnsnames.ora)

• Microsoft SQLServer: in an ODBC driver, the Database Name and Data Source Name must
use the same value.

If these requirements are not met, the Quick Report reporting feature does not work. The
requirements are documented in Build Forge Installation Guide.

Management Console cannot connect to MySQL
5.0.41 database on console start (Windows only)
If Management Console fails to start and connect to the database, it might be caused by an error
in the libmysql.dll file. To determine this, open the php_error.log file located in
C:\<BF_installationdir>\Apache\logs. If the following error message is present, the error is in
libmysql.dll.

PHP Warning: PHP Startup: Unable to load dynamic
library 'C:\Program Files\BuildForge\Apache\php\ext\php_mysqli.dll' - Invalid access to 
memory location.

To fix the problem in libmysql.dll , download and copy a new version, as follows:

1. Download mysql-noinstall-5.0.41-win32.zip from the MySql Web site, for example:
http://www.mysql.org/get/Downloads/MySQL-5.0/mysql-noinstall-5.0.41-win32.zip/from/http://mirror.x10.com/mirror/mysql/

2. In the zip file, locate \mysql-5.0.41-win32\lib\debug\libmysql.dll .

3. Stop MySql.

4. Copy libmysql.dll to the <mysql_installdir>\bin directory.

5. Start MySql.

6. Restart the Management Console.

New license server ignored on upgrade
If you enter a different host name for the license server on an upgrade install than you entered
when the Management Console was first installed, the installation program ignores the new value.

Workaround:

Do not attempt to change the license server during upgrade. To change the license server once
the system is installed or upgraded, follow the instructions in the Installation Guide: Installing the
License Server > Changing the License Server to Use.

Inconsistencies in BOM display for large BOMs
If the BOM for your project is large, you may notice that the category names for a section might
not be displayed correctly.
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Assign hidden option not hiding variable value in
logs
If you select the Assign Hidden property when you create a variable, the variable value is displayed
in the step log instead of being masked with asterisk (*) characters.

Note

If you export a project, variables with the Assign Hidden property are shown in cleartext in
the exported XML file.

This problem will be fixed in a future release of the product.

Environment variable names that contain periods
If an environment variable name contains a period, attempts to reference that variable name in
another variable fail. Shell-command parsing works differently on different platforms, which makes
finding a uniform fix difficult.

Workaround on Windows platforms only:

1. Set an environment variable to the value of the variable name you want.

Name: tmp_var      Value: Version_1.1

2. Within a step, use the variable as the variable-name portion of an assignment.

set $tmp_var = 7

When the job runs, a variable Version_1.1 is created with the value 7.
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Contacting IBM Customer Support for
Rational Products
If you have questions about installing, using, or maintaining this product, contact IBM Customer
Support as follows:

The IBM software support Internet site provides you with self-help resources and electronic problem
submission. The IBM Software Support Home page for Rational products can be found at
http://www.ibm.com/software/rational/support/.

Voice Support is available to all current contract holders by dialing a telephone number in your
country (where available). For specific country phone numbers, go to
http://www.ibm.com/planetwide/.

Note

When you contact IBM Customer Support, please be prepared to supply the following
information:

• Your name, company name, ICN number, telephone number, and e-mail address

• Your operating system, version number, and any service packs or patches you have
applied

• Product name and release number

• Your PMR number (if you are following up on a previously reported problem)

Downloading the IBM Support Assistant
The IBM Support Assistant (ISA) is a locally installed serviceability workbench that makes it both
easier and simpler to resolve software product problems. ISA is a free, stand-alone application
that you download from IBM and install on any number of machines. It runs on AIX, (RedHat
Enterprise Linux® AS), HP-UX, Solaris, and Windows® platforms.

ISA includes these features:

• Federated search

• Data collection

• Problem submission

• Education roadmaps

For more information about ISA, including instructions for downloading and installing ISA and
product plug-ins, go to the ISA Software Support page.

IBM Support Assistant: http://www.ibm.com/software/support/isa/.
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Notices for IBM Rational Build Forge
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently
available in your area. Any reference to an IBM product, program, or service is not intended to
state or imply that only that IBM product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any IBM intellectual property right
may be used instead. However, it is the user's responsibility to evaluate and verify the operation
of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You
can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where
such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION
"AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions of
the publication. IBM may make improvements and/or changes in the product(s) and/or the
program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and
do not in any manner serve as an endorsement of those Web sites. The materials at those Web
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sites are not part of the materials for this IBM product and use of those Web sites is at your own
risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i)
the exchange of information between independently created programs and other programs (including
this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
Department BCF
20 Maguire Road 
Lexington, MA 02421  
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some
cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore,
the results obtained in other operating environments may vary significantly. Some measurements
may have been made on development-level systems and there is no guarantee that these
measurements will be the same on generally available systems. Furthermore, some measurements
may have been estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products
and cannot confirm the accuracy of performance, compatibility or any other claims related to
non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To
illustrate them as completely as possible, the examples include the names of individuals, companies,
brands, and products. All of these names are fictitious and any similarity to the names and
addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate
programming techniques on various operating platforms. You may copy, modify, and distribute
these sample programs in any form without payment to IBM, for the purposes of developing, using,
marketing or distributing application programs conforming to the application programming interface
for the operating platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs.
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Trademarks
IBM, the IBM logo, Rational, ClearCase, ClearQuest, and DB2 are registered trademarks of
International Business Machines Corporation in the United States, other countries, or both. These
and other IBM trademarked terms are marked on their first occurrence in this information with the
appropriate symbol (® or ™), indicating US registered or common law trademarks owned by IBM
at the time this information was published.

Other company, product or service names may be trademarks or service marks of others.

For other IBM trademark attributions, see http://www.ibm.com/legal/copytrade.shtml
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